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CHAPTER 1

Introducing ArcExplorer™
Welcome to ArcExplorer, an Internet-enabled spatial data viewer from
ESRI that will change the way you work with GIS data. ArcExplorer is a
new, easy-to-use application that displays and queries locally stored GIS
data. Connected to the Internet (or private intranet), ArcExplorer also
becomes a Web client capable of browsing and downloading actual
vector data in industry-standard Shapefile format. Once data has been
downloaded, ArcExplorer can be disconnected and the data used in local
(standalone) mode.

What you can do with ArcExplorer
As a standalone desktop application, ArcExplorer is a complete, easy-to-use GIS data
viewer. With ArcExplorer you can:
•

View and query ESRI Shapefiles, ARC/INFO coverages, and Spatial Database
Engine (SDE) layers

•

Identify, locate, and query geographic and attribute data

•

Use powerful symbolization tools to create thematic maps based on attributes
contained in the database

•

Use standard pan and zoom tools to navigate your data

•

Display all the popular image file formats including JPEG, BMP, TIFF, and others

With ArcExplorer connected to the World Wide Web, you can also:
• Connect to web sites to view and query GIS data remotely
• Download vector data (in Shapefile format) from enabled web sites for use as locallystored GIS data in ArcExplorer or any other ESRI GIS software product
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Installing ArcExplorer
There are two ways to install ArcExplorer. If you’re on the web, and your browser is
configured with the InstallFromTheWeb Plugin, click on the Download icon and follow
the instructions . If you downloaded the file named aesetup.exe, or got ArcExplorer on a
CD, you can install it by double-clicking aesetup.exe and following the on-screen
instructions.
Note: If you are currently using any version of ESRI's Map Objects in a development
environment, you will need to either reinstall the MapObjects onto your system or reregister all components in the installation directory.
During the install procedure, you’ll be prompted to select the type of installation you
want. The following table describes the three options:
Setup option

Installation components

Typical

Installs all the components

Compact

Installs only the basic application files (not the Internet client)

Custom

Allows you to choose which components to install

To complete the installation:
1.

Click finish to accept the license agreement.

2.

Follow the on screen instructions to complete the set up.

Hardware and software requirements
The list below provides the minimum requirements for installing and running
ArcExplorer:
•

Computer—An industry-standard personal computer with at least an 80486
processor or higher Intel-based microprocessor.

•

Operating System—Windows 95 or Windows NT 4.0 or higher

•

Approximately 10 megabytes of disk space and at least 12 megabytes of RAM
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CHAPTER 2

ArcExplorer User Interface
This section describes the ArcExplorer user interface.
$UF([SORUHU:LQGRZ
0HQX%DU
7RRO%DUV
7DEOHRI
&RQWHQWV
OHJHQG
0DS9LHZ
6FDOHEDU
&XUVRU3RVLWLRQ
:LQGRZ
2YHUYLHZPDS
6WDWXVEDU
ArcExplorer Window: The complete application interface.
Menu Bar and Tool Bars: Used to access all the functions of ArcExplorer.
Table of Contents: Displays all the layers of data as themes. Use the WWW tab to
access Internet data. The Table of Contents also serves as a legend describing the data.
Map View: Where the map draws. ESRI Shapefiles (files with the .shp extension) can
be dragged and dropped straight from a Windows directory into a Map View.
Cursor Position Window: Shows the geographic position of the cursor on the Map
View in decimal degrees.
Scale Bar: Displays the scale of the current Map View.
Overview map: Displays an overview map showing the full extent of your data, with a
red box covering the area displayed in the Map View.
Status Bar: Shows context-sensitive help messages on the left and lists the current
active theme on the right.
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The Tool Bars
Most of ArcExplorer’s functionality is accessible by using the following tools. All of
these functions are also available through the Menu Bar. (The tools work in both Local
and WWW mode unless indicated otherwise in parentheses).

File/New
Use this tool to open a new ArcExplorer Window. You can open as many ArcExplorer
Windows at the same time as you want.

File/Open
Use the File Open tool to open a saved ArcExplorer session (files with .mot extension).

File/Save
Use the File Save command to save an ArcExplorer session.

Clear View (Local mode only)
Press the Clear View tool to remove all themes from the Table of Contents and return to
an empty view.

Add Themes
Use Add Themes to add one or more theme(s) to the Table of Contents (and Map View).

Print
Use Print to output the Map View to a preformatted map layout on your default printer.

Toggle
Press the Toggle tool to switch to Explorer View. In Explorer View, the Table of
Contents and Overview Map disappear, resulting in an expanded Map View.

Theme Properties (Local mode only)
Press the Theme Properties tool to open a dialog box where you can set the display
characteristics of the active theme.

Clear Thematic Classification (Local mode only)
Press Clear Thematic Classification to remove any classifications from the active theme.
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Clear Selection Highlight
Clears any highlighted features in the Map View.

Full View
Use the Full View tool to zoom the Map View to the full extent of all the themes.

Zoom to Active Themes (Local mode only)
Use the Zoom to Active Themes tool to zoom to the extent of only the active theme.

Zoom In
Use this to zoom in on the position you click or the box you drag on a view.

Zoom Out
Use the Zoom Out tool to zoom out from the position you click or the area you drag on a
view.

Pan
Pan the Map View by dragging it in any direction with the Pan tool.

Identify
Use the Identify tool to pull up the attributes of features in the active theme. Click on a
feature in the Map View; an Identify Results window will pop up.

Pan West
Pan the Map to the West.

Pan South
Pan the Map View to the South.

Pan North
Pan the Map View to the North.
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Pan East
Pan the Map View to the East.

Find features in Active Themes
Use this tool to find specific features in one or more themes. When a feature is found,
ArcExplorer will let you highlight it, zoom to it, or pan the Map View so the feature is
centered.

Query
Press Query to bring up a dialog box where you can construct a query against the active
theme. When the query is executed, the features matching the query are highlighted and
the Map View pans so they are centered.

Map Tips
Brings up a dialog box that allows you to select a field. The data for this field will then
be displayed for each feature on the map as the user moves the cursor on the screen in
Local Mode. In WWW Mode, Map Tips works with a right mouse click.

Cancel WWW request (WWW mode only)
Use this tool to cancel a request sent for a download of WWW data.

Retrieve Vector Data (WWW mode only)
Use this to download a Shapefile of the active theme and attribute data.
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Menus
All of the functions found on the Tool bars are also accessible by pulling down the Menu
Bar. Use the shortcut keys listed next to the menu choices for direct access to those
functions.
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CHAPTER 3

Using ArcExplorer
This section describes how to use ArcExplorer to: view locally stored GIS
data; retrieve GIS data over the Internet or corporate intranet; control the
display and classification of your data; work with scale and set up
contextual map tips; use Overview Maps; find and identify map features;
construct queries on your GIS data; generate summary statistics; print
your maps; and save your work.

Exploring locally stored data with ArcExplorer
When not connected to the Internet or an intranet, ArcExplorer functions as a standalone
data explorer.
To add data to an Explorer view:
to access

1.

From the File Menu, choose Add Theme, or click the Add Theme tool
the Map Contents dialog box.

2.

To add a locally stored Shapefile, ARC/INFO coverage, or image file to the Map
View, press the Add Theme tool.

3.

In the Select a file for new theme dialog box, choose the type of file to load from the
drop down list.

4.

Highlight one or more locally stored files that you wish to load click open.

5.

To add an ESRI Spatial Database Engine (SDE) theme, click the Add SDE theme
button and fill out the Connect SDE Theme dialog box to connect to an SDE
database. You may have to edit the Services file on your PC to access the SDE data
set. See the ArcExplorer home page for detailed instructions.
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6.

You can set an active theme’s display properties from the Map Contents or from the
Table of Contents.

7.

Use the up or down arrow buttons to change the drawing order of the themes.

8.

Close the Map Contents dialog box by clicking the close button.

Using ArcExplorer as an Internet client
ArcExplorer WWW access assumes that the user has a valid Win32 Internet connection.
ArcExplorer will make a connection using the default parameters as defined in the
Windows Registry by the WWW provider software.
ArcExplorer currently has one AE Enabled site available for access and more coming.
The URL to use in your connection is: http://nutria.esri.com/scripts/esrimapc .
To add an ArcExplorer web site:
1.

In the Table of Contents, click the tab labeled WWW.

2.

From the File Menu, choose Add Theme, or click the Add Theme tool
the Add ArcExplorer Web Site dialog box.

3.

Type in the URL (Universal Resource Locator) of the web site you wish to add.
(Refer to the ArcExplorer home page for information on how to set up your own
map server using ESRI Internet Map Server technology).
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to access

4.

The name of the server will show up under AEWeb. Navigate through the directory
of available GIS data and double click those themes you want to add to the Explorer
view. A Table of Contents listing all the web-based themes will appear below the
directory. Use the black and gray arrows to scroll through the list if it extends
beyond the Table of Contents window. Like a theme in a Local Table of Contents, a
WWW theme can also be made active.

To download vector data from a web site
1.

Use the Pan and Zoom tools to display the area you wish to download. By default,
ArcExplorer will download only the data showing in the Explorer view.
ArcExplorer will download data for all the themes in the table of contents, as long as
features exist in the chosen extent. Each theme will be downloaded as a separate
Shapefile.

2.

Once you’re satisfied with the extent, click the Retrieve Vector Data tool
bring up the Vector Data Options dialog box.

3.

Select the amount of vector data you wish to get and press Retrieve. (By default,
ArcExplorer will retrieve just the current extent, but you have the option to choose to
download from an extent either twice as large or four times as large as the current
extent.

4.

In the Browse for Folder dialog box, choose the folder where you want the
Shapefiles to be stored.

5.

ArcExplorer will now start downloading the data. At any time, you can halt the
download by pressing the Cancel WWW request tool .

6.

Once ArcExplorer has finished downloading the Shapefile(s) to your local drive, you
will be asked if you would like to add the vector data to your local view. If you
choose No, the Shapefiles will still be stored at the location where you specified. If
you choose Yes, ArcExplorer will automatically toggle to the local table of contents
and list the new themes. At this point you can change the display characteristics,
perform finds and queries, etc., just like any locally stored vector data.
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to

The ArcExplorer Table of Contents
The ArcExplorer Table of Contents lists all the themes that you currently have loaded
into your Map View. The Table of Contents has two modes: Local for managing locally
stored databases, and WWW for managing data stored on Web sites. The functions
described below work the same in either mode unless stated otherwise.
From the Table of Contents you can:
• Click the check box to the left of each theme’s name to turn the theme on or off in the
Map View.
• Make a theme active by single clicking its name in the Table of Contents. (Making a
theme active tells ArcExplorer which theme you want to classify, query, etc.)
• Change the drawing order by using the left mouse button to drag themes up and down
within the Table of Contents
• Double click a theme’s name to bring up the theme properties dialog box (Local mode
only).
• Use the tiny black and gray arrows to scroll the Table of Contents up and down if there
are more themes loaded than can be shown in the Table of Contents.
• Right clicking a theme’s name in the Table of Contents brings up the following theme
specific menu choices (Local mode only):

5LJKWFOLFNRQD
WKHPHLQWKH/RFDO
7DEOHRI&RQWHQWV
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Setting the Map Display Properties
You can control the background color, map outline, scroll bars, and other characteristics
of your Explorer view.
To change the Map Display Properties of your Map View
1.

Choose Map Display Properties from the View Menu.

3.

Click a color from the set of colored boxes to change the background color of the
Map View.

4.

Choose a Selection Color. This is the color which features found in a query will
draw.

5.

Select a Map Border Style. This toggles the Map View border on and off. Most
noticeable in 3D mode.

6.

Use the Cancel action when Escape key is pressed to control the screen redraw
interrupt. You can set the Escape key to stop drawing all layers, to stop drawing the
current layer, or to do nothing.

7.

Click the checkbox Scrollbars on map if you want the Explorer view to include
scroll bars at the edge of the map for panning. (This option has no effect on the
standard pan and zoom tools.)

8.

Click the checkbox 3D appearance if you want the Explorer view to have a slightly
raised (3D) effect.
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Rendering tools
The way that your locally stored data is displayed (rendered) in ArcExplorer is controlled
through the Theme Properties Dialog window. (In order to render WWW data, you must
first download that data to a local Map View.) You can access a Theme’s properties by
double clicking its name in the Table of Contents. Alternately, you can make the theme
active by single clicking it and choose Theme Properties from the Theme Menu, or click
the Theme Properties tool . The Theme Properties offers four choices for displaying
your data: Single Symbol (the default setting, shown below), Value Map, Class Breaks,
and Labels.
Single Symbol
The Single Symbol classification displays all the features in the theme with the same
color and style.

To create a Single Symbol Map
1.

Choose Single Symbol from the list of classification options.

2.

Click the Color box to bring up a color picker and change the color to one of the
available choices, or create a custom color.

3.

Click the Style drop down menu to see the different symbology choices. These will
differ depending on whether your data is point, line, or polygon.

4.

Click Apply, or click OK to change the display.
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Value Map
The Value Map classification draws features by applying a different color to each unique
value in the specified field.

To create a Value map:
1.

Choose Value map from the list of Classification options.

2.

Click on the Field drop down menu to see the list of fields in the GIS database.

3.

Select a field to use for the value map (e.g., NAME). ArcExplorer automatically
assigns random colors to each unique classification.

4.

Click Apply and click OK.

5.

Choose Clear Thematic Classification from the Theme Menu, or click the Clear
Thematic Classification tool , to remove the classification from the active theme
and return to the single symbol mode.
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Class breaks
The Class breaks option lets you create graduated color maps. Varying colors are applied
to sets of discrete values from a specified field in the database using the quantile
classification method. In the quantile method, each class is assigned the same number of
features.

To create a Class Breaks map:
1.

Choose Class breaks from the list of Classification options.

2.

Pick a variable from the Numeric field drop down list. This field contains the values
that will be mapped.

3.

Choose how many discrete breaks you want in your classification from the drop
down list.

4.

Click on the Start color and End color boxes to change the starting and ending colors
for your color ramp.

5.

Click Apply to change the color ramp.

6.

Click OK to dismiss the Layer Properties dialog.

6.

Choose Clear Thematic Classification from the Theme Menu, or click the Clear
Thematic Classification tool , to remove the classification from the active theme
and return to the single symbol mode.
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Labels
The Labels option draws maps that are labeled with data from a specified text field in the
database. Label layers can be used in conjunction with other types of layers to label
things.

To create a labeled map
1.

Choose Labels from the list of classification options.

2.

Select a Text field from the drop down list.

3.

Click the Font box to change the font style, size or color.

4.

Use the vertical and horizontal alignment tools to control the label position relative
to the center of the feature being labelled.

5.

Enter a value from 0 to 360 if you wish to rotate the labels. 0 is default and results in
a line of normal horizontal text

6.

Click the Allow Duplicates box off if you want a label to appear only once even if
there is more than one feature with the same name.

7.

Unclick the Draw features box if you wish to see only the labels and not the
underlying features that were used to create the labels.

8.

Click Apply and OK to dismiss the dialog box.

9.

Choose Clear Thematic Classification from the Theme Menu, or click the Clear
Thematic Classification tool , to remove the classification from the active theme
and return to the single symbol mode.
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Using MapTips
Map Tips are a type of contextual user assistance that work on Local Map Views. They
are small, pop-up windows that display the data for a specified field as the cursor is
moved over the features of an active theme. (In WWW mode you must right click a
feature to see the Map Tip; in Local Mode they just appear).
To create MapTips for a theme:
1.

Make a theme active by clicking its name in the Table of Contents.

2.

Click the MapTips tool

3.

Select the field that you want displayed in the Map Tip pop-up windows.

4.

Press OK.

to bring up the Map Tips dialog box.
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Working with scale
Each time you zoom in and zoom out in a view or resize a view’s window, its scale
automatically changes. ArcExplorer reports the scale in the Scale Bar. Right clicking on
the scale bar brings the Map Units and Scale Units control.

Map units
Map units are the units of the Map View’s display surface. If the data has not been
projected (i.e., stored in decimal degrees) map units are the units in which the coordinates
of the spatial data contained in your view are stored. If the view has been projected, Map
units are the units into which this data is being projected in the view. ArcExplorer
defaults to decimal degrees as the map units and that can be wrong. You must first
provide the correct map units for the scale bar units to be accurate. Right click the scale
bar to change the Map Units:

Scale Units
Scale units are what show up in the actual scale bar. Right click the scale bar to change
the scale units:

You can also control the scale at which a theme displays by setting the scale threshold for
it. For example, you could set a local streets theme to display only if you were zoomed in
close enough.
To set the Minimum and Maximum Scale Factor for a theme:
1.

Use the zoom tools to set the scale point at which you want a theme to display (or
not display).

2.

Make the theme active by clicking its name in the table of contents.

3.

Right click on the theme’s name and choose Set Minimum Scale factor if you want
the theme to turn off if you zoom any closer. Select Set Maximum Scale factor if
you want the theme to turn off if you zoom further out.

4.

Right click a theme’s name and choose Remove Scale factors to remove any scale
factors previously set for that theme.

5.

From the View menu, choose View Scale Bar to toggle the Scale bar on and off in
the Map View
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Working with the Overview Map
The Overview map window shows you a small version of the full extent of your entire
dataset with a box drawn over the current extent of the view. Overview maps are a useful
way to let users always know precisely where they are zoomed in on a large dataset.
How to create an overview map
1.

Choose Overview from the View menu to create a blank overview window in the
lower left hand corner of the application.

2.

To pick a Theme to appear in the overview, hold down the Control key while using
the right mouse button to drag and drop the theme directly into the overview
window. Alternately, you can right click on a theme and choose Use in Overview
Map from the list. A rectangular box will show you the extent of the current view.

3.

Drag the red box map inside the Overview Window to pan the Map View.

4. To get rid of the Overview Map, choose the Overview option from the view menu.
This toggles the Overview Map on and off.
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Identifying and finding features in ArcExplorer
ArcExplorer has several functions that make it easy to explore your locally stored GIS
databases.
To identify a feature in an ArcExplorer vew:
1.

Click on a theme in the Local table of contents to make it active.

2.

Click on the Identify tool

3.

Move the cursor over the view and click on the feature in the active theme you wish
to identify.

4.

The Identify results window appears listing data from all the fields in the database.
If more than one feature was identified, ArcExplorer will tell you how many and let
you pick the one you want to see from the Feature drop-down list.

.

5. Click the Close button to dismiss the Identify Results window.
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To find a specific feature by name or value in ArcExplorer:
1.

Click on a theme in the Local table of contents to make it active.

2.

Click on the Find Features tool

to bring up the Find Features dialog box.

Fill out the Find Features input form:
1.

Type a name or number in the text window.

2.

Select which type of field search you want. You can search any part of a field, the
entire field, or the start of a field.

3.

Highlight the theme or themes you want to search and press the Find button.

4.

From the list of found features, select the one you want to find by clicking the item
under the Layer column.

5.

Press Highlight to see the feature flash on the view; press the Pan to button to pan
the display to the found feature; press the Zoom to button to zoom the view into the
found feature.

6.

Sort the find results by any field by pressing the title of that column.
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Querying data with ArcExplorer
Queries allow you to select one or more features based on a precise definition of what
you are looking for. Building a query is a powerful way to select features in ArcExplorer
because a query can include multiple attributes, operators, and calculations.
To build a query in ArcExplorer:
1.

Click on a theme in the Local table of contents to make it active.

2.

Press the Query tool

3.

Select a field to query.

4.

Click on the operators, or type a query into the query window.

5.

Press the Perform Query button to execute the query.

to bring up the Query Builder.

All the features that meet the query definition will appear in the search results window.
Working with Query results:
to clear the Query Results window.

1.

Press the Clear Results button

2.

Press the Highlight Results button to highlight all the features that met the query in
the Map View. Use the Zoom to Results button to zoom in on just these features.

3.

Pick a single record from the results window and press Highlight to flash the feature.
Press Pan or Zoom to see that feature in the Map View.

4.

Sort the query results by any field by pressing the title of that column.
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To run get summary statistics from a field:
1.

In the Query Builder, press the Statistics button.

2.

Select the field you want statistics for from the Select a Field for Statistics Dialog
Box:

3.

By default, ArcExplorer will generate statistics for all records; put a check mark next
to Use Query Results if you want statistics on just the query results.

4.

The Summary Statistics will appear in the window at the lower part of the Query
Builder:

Summary
Statistics

To Save the results of a Query or Summary Statistics to an ASCII file:
1.

Press the Save Results button

2.

Name the new file and press Save.

above the Query Results window to create.

This is what the resulting delimited ASCII text file (of the previous query results) looks
like:
NAME|STATE|STATE_FIPS|CNTY_FIPS|FIPS|AREA|POP1990|POP1996|X_COORD|Y_COORD
King|53|033|53033|2188.8703|1507319|1645096|-121.74214|47.43013
Hennepin|27|053|27053|606.3642|1032431|1064043|-93.46867|45.01848
Middlesex|25|017|25017|847.526|1398468|1407602|-71.46432|42.44005
Cuyahoga|39|035|39035|469.4677|1412140|1396483|-81.66462|41.4519

Note: You can open an ASCII text file in a spreadsheet program for word processor
create a report based on a query or statistical summary.
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Copying map views for use in other applications
Sometimes you may want to copy the image of a map view for use in another Windows
application (like a word processor or drawing program). ArcExplorer makes it easy to
create a graphic image from your view.
To create a graphic from an Explorer view:
1.

Set the theme display characteristics and zoom in so that the map in the Explorer
view looks just the way you want it.

2.

Pull down the Edit menu, or right click in the Explorer view, to access the Copy to
Clipboard and Copy to File commands:

3.

Choose Copy to Clipboard if you plan to go directly into another Windows program
and paste the image in directly.

4.

Choose Copy to File if you want to create a permanent file to use at any time in the
future. If you do this, ArcExplorer will prompt you to name the new file.

5.

Use the BMP (Windows Bitmap) option if the image is composed of filled areas.

6.

Use the EMF (Enhanced Metafile) option if the map is comprised of vectors (lines).

Printing your maps
ArcExplorer automatically formats printed output from your views, complete with a
legend, title, scale bar, north arrow, and date. The map will include all themes that are
checked on in the table of contents.
To print a map of your Explorer view:
1.

Set the theme display characteristics and zoom in so that the map in the Explorer
view looks just the way you want it to look on paper.

2.

Choose Print from the File menu, or press the Print tool
process.

3.

ArcExplorer will prompt you to enter a title for the map. Type some text and press
OK to send the map to your default Windows printer. If you want to send the print
job to something other than your standard default printer (like a color inkjet, for
instance), you’ll need to set that printer as your default.
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to begin the printing

Saving your work in ArcExplorer
There may be times when you wish to save an ArcExplorer session for later use. When
you create an ArcExplorer file (*.mot), you’re not altering the data in any way. All
you’re doing is saving the location of the data (including any web sites that you
connected to during your session), as well as any classification settings that you made.
To save an Explorer view:
1.

Choose Save from the File menu, or press the Save tool

2.

Name your Explorer view.

3.

Press OK.

.

Note: If you open a saved Explorer view, and any of the data has changed location,
ArcExplorer will tell you that it experienced an error reading the shapefile and move on.
You will have to discard the *.mot file and start again.
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CHAPTER 4

Frequently asked questions
Q. What is ArcExplorer?
ArcExplorer is like a Web-enabled, lightweight version of ArcView. ArcExplorer is a
standalone application that can be used to display and query GIS data, and when
connected to an ESRI Internet Map Server, can be used to browse and fetch vector data in
standard shapefile format.
Q. What data does ArcExplorer support?
ArcExplorer can be used with ARC/INFO coverages, shapefiles, SDE layers, and a wide
variety of image formats, including JPEG and GIF.
Q. How does it work as an Internet client application?
ArcExplorer will be connectable to any ArcView or MapObjects-based Internet Map
Server site. Just type in the URL and you can browse ’maps’ or download the data that
you see.
Q. How does the vector data get delivered?
The vector data is extracted by the server, compressed, and then shipped via the Internet
to your ArcExplorer client, where it is restored in standard shapefile format. The data can
be cached temporarily, or can be stored at any location on disk.
Q. What Internet sites can I access to get data?
Currently there are only a few sites that include the capability to serve data to the
ArcExplorer via the Internet. These sites have been built and are maintained by ESRI. As
the next versions of ArcView Internet Map Server and MapObjects Internet Map Server
extensions are released, any ESRI IMS site can be configured to deliver data to
ArcExplorer clients. Eventually we believe that there will be a large worldwide network
of servers providing data to ArcExplorer clients.
Q. Is ArcExplorer a fully supported product?
Yes, ArcExplorer will be fully supported via an online support forum available from
ESRI’s external Web pages.
Q. Is the ArcExplorer customizable?
ArcExplorer is not customizable by the end user. Custom ArcExplorer implementations
can be delivered by contracting the ESRI Implementation Services Group.
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Q. Why is it free?
The idea is to provide useful, free Internet clients to capture the market and increase
ESRI Internet Map Server sales. ArcExplorer also increases the proliferation of ESRI
data formats, and will increase the number of potential SDE clients. ArcExplorer also
fulfills the ESRI vision of widespread, readily available GIS data exploration tools,
contributing to the creation of a true ’societal’ GIS.
Q: Can I just drag and drop a Shapefile to add it to an Explorer View?
Yes. ArcExplorer uses OLE technology to allow you to grab any Shapefile (*.shp) from
a Windows directory and drop it into the Explorer view to add it as a theme.
Q: Can I move the toolbars and menus around to suit my task at hand and
personal preferences?
Yes. The menu bar and button bar are both docking elements, so you can reposition them
in the interface by just clicking and dragging them around. You can even undock them so
they’re floating free anywhere in the application window. Double click a repositioned
tool or menu bar to return it to its original position.
Q: What happens when I right click in the Map View?
You get access to the following tools in a pop-up menu: Full View, Zoom in and out,
Pan. Identify, Find, and Query. (Pressing the Control key while right clicking the Map
View in WWW mode has the same effect).
Q: When I’m copying a view, either to the clipboard or to a file, how do I know
whether to save as a Windows Bitmap (BMP) or Enhanced Metefile (EMF)?
EMF is best for vectors (lines); BMP is best for areas that include fills or patterns.
Q: Can I use data that I’m seeing through the WWW client in the same Explorer
View as my locally stored data?
You have to first download the web-based data as a Shapefile and then add it to your
local view.
Q: What is ArcExplorer, in technical terms?
ArcExplorer is a 32-bit, Windows application built with MapObjects, an embeddable
mapping component technology from ESRI.
Q: Can I have more than one ArcExplorer session running concurrently?
Yes, open as many new or saved files as you wish. A new ArcExplorer application
window will appear for each session.
Q: What’s all this I keep hearing about ArcExplorer’s non-modal forms?
It means that you can leave a form open and go do other things in the program. This
might come in handy, for instance, if you where building a complex query, and needed to
check something in the view. With non-modal forms, there’s no need to dismiss the
query dialog, you just toggle between the open windows.
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